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1. Introduction 
 
CNAV 4.0 contains course and distance calculation, tides, celestial navigation and geodetic 
datum transformations.  The program is developed by the Royal Netherlands Naval College 
and is used in nautical education and voyage planning and execution.  The program is running 
under the operating systems Windows XP, 2000, NT and Windows 95/98. 
 
For CNAV 4.0 program support contact the CNAV support desk at +31-70-3162845, fax +31-
70-3162843 or at support@hydro.nl. 
 
 

2. Description 
 
CNAV 4.0 contains the following modules:  
 
Astro 
This section is an aid in celestial navigation.  Next to the determination of times of sun- and 
moon rise, astro- and solar fixes can be calculated.  The planning of the fix can be performed 
in a routine where the, for the observer, visible part of the celestial globe is projected on the 
screen.  Stars and planets used in the fix can be selected using the mouse. 
 
Tide 
This section calculates the vertical and horizontal tides for a certain port and time according to 
the Admiralty Tide Tables method.  The tidal curves are presented graphically.  Next to the 
pre-installed ports, additional ports can be created. 
  
Route 
The route section is an aid in voyage planning.  Loxodrome and Great Circle course and 
distance calculations can be performed between waypoints of a defined route. 
 
Tools 
The Tools section is to support navigational calculations.  The following calculations can be 
performed: 
• Geo/UTM, for transforming geographicals to Eastings and Northings 
• UTM/Geo, for transforming Eastings and Northings to geographicals 
• Distance and Azimuth, for course and distance calculations 
• Dead reckoning 
• Transformations, for datum transformations 
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3. Installation 
 
CNAV 4.0 can be downloaded via www.hydro.nl.  The file ‘Setup.exe’ is a Windows based 
installation program that should be run from Windows XP, 2000, NT and Windows 95/98.  
When run under Windows NT, log in as ‘administrator’.   
• Double-click on the ‘Setup.exe’ program 
• Follow the instructions of the ‘Install Manager’ 
 
Note When installing under Windows NT provide the user with access to the CNAV 
directories in order to have the possibility to save calculations 
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4. Modules 
 
Once the main program has started by pressing the icon on the desktop, via the Windows Start 
menu or by activating the CNAV40.exe program in the Program Files folder, the start page of 
the program is displayed.  On this page all modules and sub modules are displayed.  The 
modules can be started either by using the left mouse button click, using the [TAB] key on the 
keyboard to ‘jump’ to the desired (sub)module or using the [ALT] key in combination with 
the underlined letter of the desired (sub)module.  The CNAV 4.0 program is constructed 
according to the modern Windows standards and in the following descriptions of the modules 
knowledge of the standard Windows actions such as the use of left and right mouse clicks and 
the use of the standard Windows buttons above the menu bar is assumed. 
 
All modules consist of: 
• An ‘(In)Active window bar’ with a minimise, a restore and a close button in the top of the 

screen.  

• A menu bar containing the module menus  

• A button bar  

• The module dependent  in- and output fields and graphic displays.  Calculations are 
generally performed when leaving the input field.  The date is displayed in the language 
selected in the Windows Regional Settings Properties. 

 
 
Via the ‘Tools’ menu in the menu bar of all modules the navigation tools can be used.  Via the 
‘Modules’ menu the other modules can be accessed. 
 
Following is a description of all CNAV 4.0 modules including some examples. 
 
4.1 Astro 
The Astro module is used for astronomical calculations and is divided into three sub modules.  
The position input for all three sub modules is in degrees, minutes and decimal minutes 
(DD.MM.mm) 
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4.1.1 Sun Moon 
Using the input fields for position, date and LT-GMT time shift the times of sun- and moon 
rise and set are calculated.  When using the mouse in the graphics the azimuth in degrees and 
altitude of sun and moon can be viewed above of the graph.  In the left-bottom corner of the 
screen the phase of the moon, as it is visible for an observer on the Northern Hemisphere, is 
displayed.  
 
Via the file menu in the menu bar the graphs can be printed or saved in the Windows Meta 
Format (*.WMF).  These two options are also provided in the button bar. 
 

 
Graphs of the eclipse of 11th August 1999 
 
4.1.2 Astro Planning 
Via the file menu in the menu bar, files containing the selection of stars and planets can be 
opened and saved.  An observation form and a star diagram can be printed from the file menu.  
These three options are also provided in the button bar. 
 
The module provides the possibility to select the, for the observer, visible stars and planets at 
a certain position at a certain time. Using the input fields for position, date and time in GMT 
the visible stars and plane ts are displayed in the graph on the right with a colour code for the 
magnitude.  The Moon is displayed as a big white circle, the Sun as a big yellow circle.  
Using the mouse, celestial bodies can be selected.  Selected bodies are displayed in red.  
Below the graph the name, magnitude, azimuth, elevation and catalogue number of the last 
selected star or planet is displayed.  The current cursor azimuth and altitude values are 
displayed at the top left of the graph.  It is not possible to calculate a fix using the sun or 
moon. 
 
Once more than one celestial body is selected the 95% ellipse resulting from observations to 
the selected bodies is presented in the bottom left of the screen, providing assistance on the 
selection of the stars and planets.  Because of the influence of random errors in every 
measurement process, redundant measurements have to be carried out.  The more 
measurements, the better the positional accuracy, the smaller the 95% ellipse will become.  
The ellipse shows red when the selection must be improved and green for a good selection.  
The semi-major axis is the largest possible distance in nautical miles from a point on the 
ellipse to the middle. 
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Above the error ellipse a box is shown presenting the moon, as it is visible in the Northern 
Hemisphere at the entered date, time and position. 
After completing the selection an observation form can be printed, containing azimuth and 
elevation of all the selected stars at a 4 minute interval, so the sextant can be set up 
accordingly, providing a short observation time.  The results of the observations can be 
written down on the observation form. 

 
Example of selection display 
 
4.1.3 Astro Pos. fix 
Via the file menu in the menu bar, files containing the astro fix observations can be opened, 
saved and saved as.  The observations and results can be printed from the file menu.  These 
four options are also provided in the button bar.  The file menu also contains an option to 
view the star diagram.  This option will be discussed later. 
 
The module provides the possibility to calculate an astro fix.  Once the input fields for the 
dead reckoning position, date and time in GMT, Index Correction, Eye height, COG and SOG 
are entered the calculated position can be compared to the dead reckoning or approximate 
position.  This comparison will also be presented in the ‘Results’ box.  It is also possible to 
open a previously saved file.  After opening the file the measurements have to be selected in 
the ‘choose record to replay’ box. 
 
Stars used in the observations mus t be selected via the listing in the bottom of the screen.  The 
observations taken with a sextant must be entered in the observations listing together with the 
time in GMT.  By enabling and disabling celestial bodies with the check boxes under 
‘enabled’ the precision of the calculated position might be improved, as illustrated by the 95% 
error ellipse in the ‘Results’ box.  The Results section shows the A priori standard deviation.  
To recalculate with new observations the [Calc] button must be pressed. 
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Example of calculation display 
 
By double clicking in the Results graph or using the File menu the star diagram can be 
viewed.  The star diagram consists of a Graphical Display Astro Fix showing a ‘Lines of 
Position (LOP)’ graph with all the celestial bodies used in the calculation.  The yellow LOPs 
show all possible positions resulting from an observation to a single celestial body.  The red 
lines represent a residual vector from a LOP to the calculated position.  The quality control 
figures are displayed on the right side of the display. 
 
A red ellipse in the ‘Astronomical Position Fix’ and ‘Graphical Display Astro Fix’ windows 
mean that large inconsistencies exist between the various measurements.  Check the input or 
add more measurements until the ellipse is green.  
 

 
Example of a star diagram display  
 
4.2 Tide 
The Tide module is used for calculating the horizontal and vertical tides and is divided into 
two sub modules. 
 
4.2.1 Tide 
Via the file menu in the menu bar, files containing the harmonic constants used in predicted 
tides can be opened, edited and a printed.  These options are also provided in the button bar.   
On opening files there are two options.  Either to open a *.str file for stream data or opening a 
*.tid file for vertical tides data.  Via the File menu the hourly values and high and low water 
times can be viewed.   
 



CNAV 4.0 Appendices                                                                              

The Hydrographer of the Royal Netherlands Navy 
March 2004 

On installing the CNAV program two tide files are provided.  These files contain the 
harmonic constants for ports as provided in part III of the Admiralty Tide Tables (ATT).  
After entering the date and selecting one or two ports the graph displays the tidal curve for the 
location(s).  While using the mouse in the graph the current cursor position time and height(s) 
can be viewed above the graph. 
 
CNAV can provide world wide tidal predictions.   Via the File menu files for other parts of 
the world can be created using the harmonic constants section of the ATT.  The time in both 
sub modules is equivalent to the time standard used in the ATT for a specific port.     
 

 
Example of tidal calculations display 
 
The calculations performed using the ATT harmonic constants do not provide very accurate 
tidal predictions.  Along the Dutch coast the tides are too complex for a proper description 
using the ATT method.  For this area the HP33 Tide tables published by the Netherlands 
Hydrographic Office are more reliable. It is emphasized that there may be considerable 
differences between predicted and observed tidal heights.  These differences are nearly always 
due to meteorological conditions, only predictable for a short period of time.  An onshore 
breeze usually causes higher water levels and earlier times of high and low waters.  Offshore 
winds tend to cause an opposite effect.  The barometric pressure also has an influence on the 
water level.  The higher the pressure, the lower the water level and the other way round. 
 

 
HP33 cover 
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4.2.2 Streams 
Via the file menu in the menu bar, files containing the harmonic constants used in predicted 
streams can be opened, edited and a printed.  These options are also provided in the button 
bar.   On opening files there are two options.  Either to open a *.str file for stream data or to 
open a *.tid file for vertical tides data.  Via the File menu the hourly values and maximum 
stream times can be viewed.   
 

 
Example of a stream graph display 
 
On installing the CNAV program a stream file is provided.  The file contains the harmonic 
constants for tidal streams for two ports as provided in the Admiralty Tide Tables (ATT).  
After filling in the date and selecting one or two ports the graph displays the stream curve for 
the location(s).  While using the mouse in the graph the current cursor position time and 
rate(s) can be viewed above the graph.  The two main directions in which the streams are 
heading are displayed left of the graphs. 
 
4.3 Route 
Via the file menu in the menu bar, files containing the Track (*.trk) and Area (*.are) positions 
and calculations can be opened, saved and saved as.  These three options are also provided in 
the button bar.  The file menu also provides an option to create a new file. 
 
On installing the CNAV program two *.trk and a *.are files are provided.  These files contain 
several waypoints.  The track files define a route.  The area files define an area such as an 
anchorage or exercise area.  These files can be selected using the open option in the file menu.  
By using the right mouse button in the map the tracks and areas can be drawn, erased and 
deleted.  By dragging from the left bottom corner to the top right corner and pressing the left 
mouse button the map can be zoomed in. 
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Example of Track display 
 
The track data can be displayed by double clicking the desired track in the ‘Available Tracks’ 
box.  The page shows the display format of the coordinates, the geodetic datum and ellipsoid, 
the date and time of departure and a list of coordinates.  The list consists of the following 
parameters: 
• Name WPT, the name of the waypoint 
• Latitude, longitude 
• Course lox, loxodrome (rhumbline) course to the next waypoint, calculated by the 

program 
• Dist. lox, loxodrome distance to the next waypoint, calculated by the program 
• DTG loxo, loxodrome distance to destination, calculated by the program 
• SOG, speed over ground, either calculated by CNAV or set by user  
• delta T, time to next waypoint, either calculated by CNAV or set by user 
• Date/Time, on arrival at waypoint 
• TTG, time to go to destination 
Following are Great Circle (geodetic line) parameters [-->GrC] 
• COD/COA, course of departure/course of arrival 
• Distance, distance to the next waypoint 
• DTG, distance to destination 
 
The geodetic datum must be provided at the creation of the file and cannot be altered. 
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Example of Route and Planning display 
 
Parameters can be edited by double clicking a waypoint in the list.  A change in one of the 
parameters causes a change in the other parameters as well.  Using the right mouse click 
opens up another menu.  Using this menu waypoints can be edited and deleted.  To insert 
waypoints, tracks and crossings first select a waypoint with the left mouse button. 
 

 
 
A new track can be created by opening a new file in the file menu.  After selecting a geodetic 
datum and adding a required waypoint the next waypoint can be added after pressing the add 
button.  The new track or area can be saved by pressing the finish but ton.  Track files must be 
saved as *.trk file and area files as *.are file. 
 
4.4 Tools 
The Tools module is used for navigational calculations and is divided into 5 sub modules.  
The menu bar of the sub modules in the Tools module consist of only the file menu with a 
print and an exit function.  There is no button bar in the sub modules. 
 
4.4.1 Geo UTM 
After selecting a position format and an ellipsoid, geographical positions can be converted to 
grid positions. On leaving the position field a central meridian is automatically proposed.  The 
scale factor and convergence for the position are presented as well. 
 

 
Example of Geo UTM display 
 
4.4.2 UTM Geo 
After selecting a position format and an ellipsoid grid, positions can be converted to 
geographical positions. On leaving the position field a central meridian is automatically 
proposed.  The scale factor and meridian convergence for the position are also presented for 
both northern and southern latitudes. 



CNAV 4.0 Appendices                                                                              

The Hydrographer of the Royal Netherlands Navy 
March 2004 

 

 
Example of UTM Geo display 
 
4.4.3 Dist. Azimuth 
After selecting a position format and a datum or ellipsoid the great circle and loxodrome 
distance and course between two geographical positions can be calculated.  The difference 
between the great circle and the loxodrome distance is also presented.  The vertex is shown in 
the box at the bottom. 

 
Example of Distance Course display 
 
4.4.4 Dead reckoning 
After selecting a position format, an ellipsoid, a start date and time and a start position the 
different legs must be filled in.  The results are arrival positions and times. 
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Example of Dead reckoning display 
  
4.4.5 Transformations  
After selecting a position format and the two datums, a datum transformation between the two 
can be performed using the parameters on the right.  For comparison the ‘virtual’ difference 
between the two coordinates is also displayed on the right. 
 

 
Example of the Datum Transformations display 
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5. Terms and Abbreviations 
 
95% ellipse An ellipse that shows the area in which the position of the 

observer lies with a 95% probability.  The middle is the 
estimated position. 

Altitude The vertical angle between the plane of the horizon and the line 
to a celestial body. 

Alt. (obs.)  Observed altitude. 
Alt. (Calc.)  Calculated altitude. 
Alt. (Trans.)  Difference between calculated and observed 
A priori Std. deviation The (expected) standard deviation of a random variable.  In 

CNAV 1.5 nmi for an observation to a celestial body. 
Azimuth A horizontal angle measured clockwise from the meridian. 
Civil twilight  The periods of incomplete darkness following sunset or 

preceding sunrise, as the darker limit occurs when the centre of 
the sun is 6° below the celestial horizon (the horizontal plane 
through the centre of the earth perpendicular to the zenith–nadir 
line). 

COA Course Of Arrival. 
COD Course Of Departure. 
COG Course Over Ground. 
Covariance matrix Description of the precision of the calculated position.  Top left 

is variance in N-S direction in nmi, bottom right is variance in 
E-W direction.  The two other values are a measure for the 
relationship between the first two values. 

D_Time Delta time, difference between start and stop time or duration 
Datum Geodetic model of the earth acting as a reference surface for 

position control consisting of a reference ellipsoide and three 
translations X, Y and Z in meters to indicate the difference with 
the World Geodetic System 1984 (WGS’84) datum. 

Dead reckoning Position estimate based on speed and heading of a vessel, 
without reference to external aids. 

DOA Date Of Arrival. 
DTG Distance To Go. 
Elevation The vertical distance of a point or a level , on or affixed to the 

earth, measured from mean sea level. 
Ellipsoid Model of the earth constructed by rotating an ellipse around its 

minor axis.  Often called reference spheroid. 
Eye height Eye height of the observer above mean sea level. 
Geo Geographical coordinates, a system of spherical coordinates for 

defining positions of points on the earth (example 52° 04’ North, 
4° 17’ East) 

GMT Greenwich Mean Time.  Time based upon the Greenwich 
meridian as a reference. 

GrC Great Circle.  The intersection of a sphere and a plane through 
its centre.   A great circle is the shortest connection between two 
waypoints with different courses at departure and arrival.  This 
results in a curved line on a (Mercator) chart. 

Index Correction Known error of the sextant. 
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Loxodrome A curve on the surface of a sphere, intersecting all great circles 
of the sphere at a constant oblique angle. A loxodrome is a 
connection between two waypoints with the same course, this is 
a straight line on a chart with a Mercator projection.   

LT Local Time.  The local time of a reference zone (i.e. Central 
European Time = GMT +1 hour) 

m In Astro Planning.  ‘m’ is the magnitude of a celestial body.  
Relative brightness of a celestial body.  According to the 
accepted classification a star of the 1st magnitude is a hundred 
times as bright as a star of the 6th magnitude (the faintest star 
that can be seen with the unaided eye). 

Mer. Convergence Meridian Convergence.  At any point of a cartographic 
projection, the angle between the meridian, as represented on the 
plane of the projection and the grid in use, and the grid north 
line. 

Nautical twilight The periods of incomplete darkness following sunset or 
preceding sunrise, as the darker limit occurs when the centre of 
the sun is 12° below the celestial horizon (the horizontal plane 
through the centre of the earth perpendicular to the zenith –nadir 
line). 

nmi nautical miles (1852m) 
Resid. Difference in nmi between the Calculated position and the LOP 

for the observation the specific star in the first column of the 
row. 

Scale factor A multiplier used to convert a grid distance in a map projection 
to a true distance on a spheroid. 

SOG Speed Over Ground. 
Sun Rise Crossing of the (apparent) horizon by the upper limb of the 

ascending sun  
Sun Set Crossing of the (apparent) horizon by the upper limb of the 

descending sun  
Sun Transit Crossing of the sun over the meridian of the observer. 
TOA Time Of Arrival 
TTG Time To Go 
UTM Universal Transverse Mercator, a grid system in which a grid 

network is applied to Transverse Mercator projections of zones 
of the earth’s surface.  The earth is divided into 60 zones with a 
width of 6°.  On the Northern Hemisphere the Northing 
coordinate is in metres from the equator and the Easting 
coordinate is in metres from the central meridian +500.000m. 

Vertex The highest point.  On a great circle the point nearest to a pole. 
Wpt Waypoint, a position in a route which is the start or end point of 

a leg. 
 


